
第 1 章

CFD概述

计算流体力学（Computational Fluid Dynamics，CFD）是连续介质力学的一个重要分

支，是研究流体（包含气体及液体）现象及相关力学行为的学科。计算流体力学的基本定义

是通过计算机进行数值计算，模拟流体流动时的各种相关物理现象，包括气体、液体流动、

热传递、声场等。计算流体力学通过应用各种离散化的数学方法，对流体力学的各类问题

进行数值实验、计算机模拟和分析研究，以解决各种实际问题，因此被广泛应用于航空航

天设计、车辆设计、生物医学工业、化学工业处理、涡轮机设计、半导体设计等诸多工程

领域。

1.1　CFD总体介绍

CFD（计算流体力学）是 ANSYS 公司研发的一款功能强大的软件，专门用于模拟和分

析流体流动、热传递，以及相关的物理过程。CFD 在许多行业中有着广泛应用，主要包括：

航空航天：飞机的气动性能分析、涡流研究等；汽车：车辆空气动力学、热管理系统分析；

建筑：建筑物的通风、空调、火灾和烟雾扩散分析；能源：涡轮机、换热器等设备的流体流

动和热传递研究；生物医学：生物流体动力学的研究，如血液流动模拟等。

CFD 提供了一系列强大的功能，以支持复杂流体流动和热传递问题的分析，主要包括：

流动模拟：可以模拟层流、湍流、压缩流、非压缩流等多种流动状态；热传递分析：支持对

导热、对流和辐射等多种热传递机制的分析；多物理场耦合：可以与结构分析、化学反应、

粒子动力学等模块耦合，进行多物理场模拟；自由表面流动：处理液体与气体的相互作用，

如波浪、喷雾等现象；气动声学：模拟流动产生的噪声及其他声学现象。

CFD 是一个高效、灵活的流体动力学分析工具，可以帮助工程师和科学家深入理解流体

行为，优化设计，提高产品性能。无论是在学术研究还是工业应用中，CFD 都是进行流体分

析的重要工具。但是 CFD 对计算资源的要求较高，复杂模拟可能需要较长的计算时间，对

用户的专业知识要求较高。因此，本书旨在为工程师和科学家提供通俗易懂的背景知识和理

论实例支撑。
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1.2　CFD的主要模块

CFD 软件作为一款流体力学数值模拟仿真软件，从前处理、运算求解器及后处理 3 部分

来看，相应的模块主要依次为：ICEM CFD、Fluent/CFX 和 CFD-Post。此外，为求解特殊问

题的需要，Fluent/CFX 中还包含湍流模型、旋转机械、多相流、传热及辐射、燃烧、流固耦

合、运动网格等模块。最后，CFD 还为用户提供了 GAMBIT、G/Turbo 和 TGrid 接口。CFD
软件的结构/模块关系如图 1-1 所示。

图 1-1　ANSYS CFD 软件模块

1.2.1　ICEM CFD

ICEM CFD 是由 ANSYS 公司推出的一款先进的计算流体力学（CFD）网格生成软件，

全名为 ANSYS ICEM CFD，主要用于为 CFD 分析过程生成高质量的网格。ICEM CFD 能够

处理复杂的几何形状和流动问题，特别是在需要精确网格分布的高精度流体模拟中发挥着重

要作用。它广泛应用于工程模拟、分析和优化的各个领域，分别介绍如下：

（1）应用于汽车气动性能模拟的高质量网格创建，帮助工程师优化车身设计，减少空

气阻力。

（2）应用于帮助分析发动机、制动系统和空调系统热流、温度分布和散热问题。

（3）应用于飞机、火箭、无人机等航空航天器的气动设计与优化，模拟空气流动对飞行

器表面压力、升力及阻力的影响。

（4）应用于风力发电机的设计，分析风力叶片的气动性能及其对整体发电效率的影响。

（5）应用于核反应堆冷却系统、热交换器和冷却塔等复杂几何中生成适应性网格。

（6）应用于船体设计、船舶水动力性能优化，如减少水阻力、提高航速等。

（7）应用于海上平台、浮动风电平台的设计，优化其结构的抗波浪、抗风能力。

（8）应用于化工反应器、管道、过滤器等设备的设计中，分析流体流动、传热、混合与

反应过程。

ICEM CFD 是一款功能强大的网格生成工具，广泛应用于各行各业的流体分析中。工程



3

 第 1 章 CFD 概述

师通过使用它，可以生成高质量的网格，从而提高 CFD 模拟的精度与效率，优化设计、提

升性能，并有效解决复杂的流体力学问题。

1.2.2　Fluent/CFX

自 1983 年推出以来，Fluent 一直在计算流体力学（CFD）领域占据领先地位。该软件

结合了灵活的非结构化网格方法、解驱动的自适应网格技术及丰富的物理模型，能够提供卓

越的收敛速度和高度精确的求解能力。它以广阔的使用范围聚集了大批国际著名用户，如

美国能源部（DOE）、美国国防部（DOD）、美国国家航空航天局（NASA）等国家政府机

构，以及波音、劳斯莱斯（RR）、福特、宝马（BMW）、通用电气（GE）、三菱汽车等世界

领先的高技术企业。Fluent/CFX 可以高效、高精度地模拟不可压缩流体及高度可压缩流体的

复杂流动现象，涵盖船舶工程、航空航天、流体机械、汽车工业、新能源、石油化工、计算

机科学、材料科学、冶金工程、生物医学等多个领域，分别介绍如下：

（1）应用于汽车外形设计的气动优化，模拟空气流动对车身、车顶、车窗、车底等区域

的影响，帮助设计更加节能的汽车。通过优化车身形状来减少空气阻力，提高燃油效率。

（2）应用于模拟汽车发动机的冷却系统、散热器、空调系统的流体热交换过程，帮助设

计更高效的热管理系统。

（3）应用于飞行器的气动设计与优化，包括机翼、机身、尾翼等部件的气流模拟，分析

气流对飞行性能的影响，如升力、阻力、稳定性等。

（4）应用于模拟航空发动机内部的气流、燃烧过程、热交换和排放等问题，优化发动机

的设计，提高效率并减少排放。

（5）应用于风力发电机叶片的气动分析和设计，帮助优化叶片形状，提高发电效率。通

过模拟不同风速和方向下的叶片表现，可以设计出更高效的风力发电系统。

（6）应用于发电厂热交换器、冷却塔和锅炉系统的设计和优化，模拟热流和流体分布，

帮助提高热效率和降低能耗。

（7）应用于化工反应器的流体动力学分析，帮助优化反应器的流动分布、温度场、浓度

场等，提升反应效率和产品质量。

（8）应用于船舶的水动力分析，帮助设计优化船体、推进系统、螺旋桨等部件，减少水

阻力，提高航速和燃油效率。

ANSYS Fluent 是一款功能完备的 CFD 软件，应用范围较广。借助 Fluent，工程师可以

优化设计、提高效率、确保安全，进而解决复杂的流体力学和热力学问题。

ANSYS CFX 软件是一款高度便捷的商业流体动力学计算工具，它引入了先进方法，

并给出了从网格规划、流体求解到后处理的一套完善的项目解决方案。其核心组件主要有 4
种，即 CFX-Mesh、CFX-Pre、CFX-Solver 及 CFX-Post。其中，CFX-Solver 模块承载了整个

程序的求解核心部分，它集成了有限体积法与有限元方法的优势，既保留了有限体积法的能

量守恒特性，也提升了计算精度。另外，CFX 软件还引入了世界领先的全隐式耦合多网格线

性计算方法，并与自适应的网格分析方式相结合，因此在求解速度方面领先于其他的流体参
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数应用软件。其凭借强大的前处理、求解和后处理模块，在航空航天、船舶工程、新能源、

石油化工、机械制造、汽车工业、生物工程、水处理、火灾安全、冶金、大气环境等多个行

业领域得到了广泛且不可替代的应用，分别介绍如下：

（1）应用于模拟飞行器的空气动力学性能，如翼型的升力、阻力、流线等，这对于提高

飞行效率、燃油经济性及安全性至关重要。

（2）应用于航空航天器的复杂热传递问题，模拟高温气流与发动机内部及外部表面的热

交换，优化发动机热设计。

（3）应用于汽车发动机、刹车系统、电池和其他关键部件的散热系统的设计，模拟冷却

液流动、空气流动及热传递等。

（4）应用于模拟锅炉、燃烧室及其他热力设备中的气流和热交换过程，优化能量转换效

率，减少排放。

（5）应用于模拟风力涡轮机的空气动力学性能、流场分布、湍流特性等，从而帮助设计

高效的风力涡轮。

（6）应用于石油化工行业中的模拟化学反应、混合过程、流体流动、热交换等，帮助优

化反应器设计和生产过程。

（7）应用于模拟船体与水流的相互作用，分析海洋平台或其他结构在海流中的稳定性，

优化船舶的水动力性能。

（8）应用于模拟电子元件（如半导体器件、电源模块等）的热传递过程，帮助设计有效

的散热系统，防止设备过热。

ANSYS CFX 的应用范围非常广泛，几乎涵盖了所有涉及流体流动、热传递，以及多物

理场耦合分析的工程领域。通过提供高精度的数值模拟，帮助工程师和设计师优化产品性

能，提高设计效率，降低成本，减少实验次数，甚至在某些情况下，还能提前识别潜在问

题，避免可能的故障或失败。

1.2.3　CFD-Post

CFD-Post 是 ANSYS 公司开发的后处理软件工具，专门用于分析和可视化计算流体力学

（CFD）仿真结果。它允许用户从 CFD 仿真数据中提取关键信息，并以直观的可视化形式

展示，从而帮助用户更好地理解、分析和优化流体系统的性能。CFD-Post 提供了处理复杂

数据的有效方式，用户可以查看流场中的温度、湍流、速度、压力特性等物理量的分布，深

入分析流体系统的行为。该工具在多个行业领域得到广泛应用，主要包括以下几个：

（1）应用于航空航天领域中模拟和分析飞机、火箭、发动机等的气动性能。通过分析空

气流动、压强分布、升阻力等数据，工程师可以优化机体形状，提升飞行效率，减少燃油消

耗，确保飞行安全。

（2）应用于汽车设计中分析空气动力学性能，优化车身外形，降低空气阻力，提高燃油

效率和稳定性。此外，也用于研究车内气流、冷却系统、排气系统等流体相关问题。

（3）在风力发电、核电、火电、太阳能等能源领域，CFD-Post 被广泛应用于模拟流体
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流动、热交换和传热过程。例如，可以利用 CFD-Post 对风力涡轮机的气动性能进行分析，

优化燃气轮机的气流分布，或研究核反应堆内部的流动特性，从而提升设计优化效果。

（4）应用于建筑行业中室内外气流模拟，评估空调系统的效果，优化通风设计，提升建

筑物能源效率。它还可用于模拟城市环境的空气污染扩散，进行环境影响评估。

（5）应用于化学工程中模拟化学反应器、分离设备、泵、管道等设备中的流体流动及

传热过程。它可以帮助优化混合、分离、反应和热交换等过程，提高工业过程的效率和安

全性。

CFD-Post 是一个强大且灵活的后处理工具，通过对 CFD 仿真数据的深入分析和可视

化，使得工程师能够更好地理解和优化流体系统的行为。它在多个行业中得到了广泛应用，

尤其是在航空航天、汽车、能源、建筑等领域，对于设计优化、性能评估和安全性验证起到

了至关重要的作用。

1.3　CFD的使用环境

基于 ANSYS 的全面运行环境，ICEM CFD 为生成 ANSYS CFD 模型、交互式提交作

业，以及监控和评估计算结果提供了一个简洁直观的界面。ANSYS CFD 由多个功能模块组

成，每个模块对应模拟过程中的一个关键步骤。用户可以逐步完成各个模块的操作，逐渐构

建起完整的分析模型。

ANSYS CFD 的求解器通过读取由 ICEM CFD 生成的输入文件进行分析，并将计算结果

反馈至 Fluent 或 CFX。这样，用户可以实时观测并监控作业过程，将生成的结果输出至

数据库。最终，用户在 CFD-Post 的在线可视化模块中快速便捷地查看并分析这些输出

结果。

启动 CFX 应用程序有两种方法，分别为直接启动和在 Workbench 中启动。

1. 直接启动

1）Windows 系统

单击“开始”按钮，选择“所有程序” → ANSYS 2022 R1 → CFX 2022R1 命令。或者，

在命令提示符（DOS 窗口）中输入命令 C：\ProgramFiles\ANSYSInc\V22\CFX\bin\cfx.exe  
来启动 CFX 应用程序。   

2）Linux 系统

在终端窗口中输入命令 C：\ProgramFiles\ANSYSInc\V22\CFX\bin\cfx.exe，即可启动 CFX应用 
程序。

2. 在 Workbench 中启动

在 Workbench 中启动 CFX 计算模块时，第一步需要启动 Workbench 程序，第二步需要导

入 CFX 计算模块。详细步骤为：在操作系统中选择 Start → Programs → ANSYS 2022 R1 命令，

或在命令提示符中输入 ANSYS 2022 R1，运行 ANSYS 2022 R1 Workbench（见图 1-2）。打开启动
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界面后，找到主界面中的 Toolbox（工具箱）区域并双击打开，选择 Component Systems → CFX
（见图 1-3）选项，即可在项目管理区中创建一个新的分析项目 A（见图 1-4），并进入 CFX 项

目工作区（见图 1-5）。

图 1-2　ANSYS 2022 R1 Workbench 启动界面

 
图 1-3　Workbench 主界面
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图 1-4　创建 CFX 分析项目 A

画布 视图区

 
图 1-5　CFX 项目工作区

（1）标题栏。显示了正在运行的 ANSYS/CFD 版本，以及当前模型数据库的名称。

（2）菜单栏。显式所有可用菜单，用户可以通过菜单调用相应的功能。不同类型的数据

库所包含的菜单选项也有所不同。

（3）工具栏。工具栏为用户提供了菜单栏中一些功能的快捷方式，用户也可以通过菜单

栏访问这些功能。

（4）环境栏。环境栏中包含了对项目进行变化的模块，即 Import Project、 Refresh 
Project 和 Update Project。

（5）模型树/结果树。在 ANSYS/CFX 的左侧区域，包含了模型树和结果树，通过图 1-3
中创建 CFX 分析项目 A 中的 Setup 模块进入。模型树展示了数据库中所有的模型和分析任
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务，按类别列出了各个功能模块及其重要的工具，支持菜单栏中的大部分功能。结果树则列

出了所有结果文件及可视化模块中的众多工具，支持大多数结果显示功能。

（6）画布。画布区用于摆放视图。

（7）视图区。用于模型的建立和仿真结果的显示。

（8）细节展示区。用户在 ANSYS/CFX 中进行的各种操作都会在该区域得到相应的提

示，用户可根据提示进行相关操作。

（9）标尺 / 空间坐标轴。用于对建模模型进行准确的位置和尺寸标定。

1.4　CFD的文件系统

在计算分析用户所创建的模型过程中，CFD 软件会生成一系列的文件，不同的文件类型

具有不同的文件后缀，总计可以分为 9 个文件类别，如表 1-1 所示。

表 1-1　CFD 文件系统

文 件 类 型
文件名及 
扩展名

说　　明

前处理文件
*.cfx CFX 模型文件，包含定义模拟的基本信息和设置，包括物理模型、边界条件等

*.def CFX 定义文件，保存了 CFX-Pre 中设置的所有模拟参数，通常用于模型的输入和输出

日志文件 *.log 日志文件，记录求解过程中的详细信息，包括任何错误或警告信息，帮助用户进行故障排查

计算文件 *.mon 监测文件，保存求解过程中监测的关键参数（如收敛性、残差等），可用于评估计算的稳定性

后处理文件

*.out 输出文件，包含 CFX 求解过程中的计算信息和结果日志，帮助用户了解求解的进展情况

*.res
结果文件，存储求解后得到的流体动力学计算结果，如速度、压力等变量，供后续分析

和可视化使用

*.fld 领域文件，包含流体域中的计算数据，通常用于后处理和可视化工具（如 CFX-Post）

*.xml
可扩展标记语言文件，通常用于存储模型的结构化数据，便于与其他软件或工具进行数

据交换

*.xfr 交换文件，保存模型在不同计算平台之间传输时所需的信息，确保模型的完整性和可用性

1.5　CFD的新功能

计算流体力学（CFD）软件不断在技术和功能上进行更新，为了满足日益增长的工程需

求和应用场景。CFD 软件（包括 ANSYS CFX、Fluent 等）推出了一些新功能。
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1. 增强的流体动力学模拟

（1）改进的湍流模型：引入了更高效和准确的湍流模型，包括改进的 k-ε 和 k-ω 模型，

尤其是在复杂流动和低雷诺数流动的仿真中，提升了计算精度。

（2）改进的多相流模拟：在多相流模拟中，增强了对液 - 气、液 - 固和气 - 固等多相系统

的支持，包括改进的相互作用模型，使得模拟更加稳定和高效。

（3）更精确的热传递与热交换模拟：对于热传递与热交换的模拟（包括导热、热对流和

热辐射），ANSYS 2022 R1 提供了改进的热模型，支持更多物理现象的同时模拟，如流体与

结构之间的热耦合。

2. 更高效的网格生成

（1）改进的网格划分工具：ANSYS 2022 R1 提升了 ANSYS Meshing 的网格划分效率，

尤其是在大规模和复杂几何形状的网格生成方面。对非结构化网格、混合网格和自适应网格

的支持更为增强，帮助用户更快速地生成高质量网格。

（2）自动化网格优化：对于大规模问题，网格优化的自动化功能可以帮助用户节省大量

的手动操作时间。

3. 增强的并行计算与硬件加速

（1）GPU 加速支持：ANSYS 2022 R1 在流体力学、结构力学和多物理场仿真中加强了

对 GPU 加速的支持，利用现代 GPU 硬件加速计算，显著提高求解效率，特别是在处理大规

模计算任务时。

（2）高性能计算优化：提高了对并行计算的支持，包括对 MPI（消息传递接口） 和 
OpenMP 的改进，使得多核和分布式计算系统的性能得到显著提升。

4. 多物理场耦合

（1）流固耦合（FSI）优化：ANSYS 2022 R1 对流固耦合（FSI）分析进行了改进，使

得流体和结构之间的交互更加精确。用户可以更容易地处理流体-结构-热（FSHT）等复杂的

多物理场问题。

（2）电磁-热-结构耦合：新版本中增加了电磁与热传递，以及结构分析的耦合功能，支

持更精细的电子设备热管理和多物理场问题的仿真。

（3）增强的磁流体动力学（MHD）：改进了磁流体动力学模拟，特别是在高导电流体、

磁场及电流相互作用的分析方面。

5. 增强的用户界面与操作体验

（1）改进的 CFX 与 Fluent 界面：ANSYS 2022 R1 优化了 CFX 和 Fluent 界面的用户交

互性，提升了图形用户界面的响应速度，增强了可视化功能，使得流场结果分析更为直观。

（2）更易用的后处理工具：新版本提供了更多数据可视化工具，如增强了流线、等值

面、切片图的功能，可以帮助用户更清晰地分析计算结果。

（3）增强的自动化和脚本功能：增加了对 Python 脚本 和 Journal 文件的增强支持，用户

可以更方便地进行批处理和自动化操作。

6. 增强的模拟精度和结果验证

（1）网格独立性分析：通过增强的自动化工具，ANSYS 2022 R1 使得网格独立性测试
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和验证变得更加高效，能够快速评估不同网格密度对结果的影响。

（2）改进的误差分析：提供了更多误差评估和收敛性检查工具，帮助用户确保仿真结果的准

确性。

7. 增强的材料模型

（1）新材料库：ANSYS 2022 R1 更新了内置的材料库，加入了更多类型的先进材料模

型（如复合材料、智能材料、纳米材料等）和物理属性，支持更为广泛的应用。

（2）自定义材料模型支持：用户可以更方便地定义和导入自定义的材料模型，尤其在非

线性分析和复杂材料行为的模拟中。

8. 云计算支持

云仿真：ANSYS 2022 R1 增强了对云计算平台的支持，用户可以将仿真任务迁移到云

端，进行弹性计算和远程计算，避免了本地硬件资源的限制。

9. 虚拟现实（VR）和增强现实（AR）

VR/AR 集成：一些 CFD 软件开始探索将虚拟现实和增强现实技术应用于流场可视化，

使工程师可以在三维环境中更直观地分析结果。

1.6　CFD的分析步骤

计算流体力学（CFD）分析是一种用于模拟和分析流体流动、热传递和其他物理现象的

强大工具。一个标准 CFD 分析过程的详细步骤通常为定义问题、建模、设置物理模型、边

界条件和初始条件设置、求解、结果后处理、验证和分析、优化与迭代。但是总体上分为 3
个部分，分别为前处理、分析运算和后处理。在 ANSYS CFD 中实现这 3 个步骤的具体方法

如下。

1.6.1　前处理

前处理器模块（Preprocessor）主要用于完成前处理的相关设置工作，即负责向 CFD 软
件输入所需的模型和数据。这个过程通常通过与求解器相配套的前处理对话框或者图形界面

辅助完成。前处理是计算流体力学（CFD）仿真中的关键步骤，为流体模拟提供了必要的几

何和网格信息。前处理的主要步骤包括以下几个重要环节。

1. 几何建模

（1）导入模型：可以使用 ANSYS DesignModeler 或 ANSYS SpaceClaim 等工具创建或

导入几何模型。支持多种文件格式，如 STEP、IGES 和 STL。
（2）几何修整：对导入的模型进行检查和修整，确保几何体的完整性。常见操作包括修

复小缺陷、简化复杂几何、添加必要的特征等。
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2. 网格生成

（1）选择网格类型：在 CFD 分析中，通常使用结构化网格或非结构化网格。如何选择

合适的网格类型取决于流场的复杂性和分析需求。

（2）网格划分：使用 ANSYS Meshing 工具进行网格划分。可以设置网格的尺寸、密度

和分布，以便在关键区域（如边界层、障碍物附近）生成更精细的网格。

（3）网格质量检查：确保网格的质量合适，如检查网格的扭曲程度、非正交度等。这对

于保证模拟结果的准确性至关重要。

3. 物理设置

（1）定义材料属性：为模拟选择合适的材料模型，并定义流体的各项相关物理参数，如

热导率、密度、黏度等。

（2）设置边界条件：根据实际问题的需要设置边界条件，包括入口、出口、墙面和对称

面等。这些条件将直接影响流体的流动特性。

（3）定义初始条件：为求解器提供初始流场条件，通常涉及速度、压力和温度等参数。

在解决计算流动的问题时，求解的精度通常根据网格内单位的数量来确定，或者是单元

中的节点上确定的数值。所以，网格规划在前处理器中是非常重要且不能遗漏的一个环节。

相应的，单元数量越多、体积也越小，那么解的准确度越高，而这就意味着要耗费更多的计

算资源与时间。所以，如果想要进一步提升计算精度，避免浪费计算资源和时间，通常在物

理量梯度变化较大或需要重点研究的区域进行局部网格细化。更重要的是，在前处理模块中

生成的计算网格数量需要在精度和计算成本之间找到平衡。

1.6.2　分析运算

分析运算工作由求解器完成。CFD 求解器的主要功能是：读取前处理器提供的数据（如

网格数量、边界条件、控制参数等），利用软件内置的求解算法进行分析计算，最后将结果

输出。分析过程主要包括以下几个重要步骤：

1. 选择求解器

根据问题的性质选择合适的求解器，常用的求解器包括以下几种：

（1）显式求解器：适用于瞬态问题，计算简单但可能不稳定。

（2）隐式求解器：适用于稳态或长时间模拟，通常更加稳定，但计算量较大。

（3）压缩/不可压求解器：根据流体类型选择相应的求解器。

2. 求解过程

在求解过程中，CFD 软件会使用数值方法（如有限体积法、有限元法等）来求解流体动

力学方程，包括以下几个：

（1）连续性方程：确保质量守恒。

（2）动量方程：描述流体的运动。

（3）能量方程：用于热传递模拟。

（4）湍流模型：如 k-ε 模型、k-ω 模型等，用于处理湍流流动。
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3. 收敛性检查

在求解过程中，CFD 软件会不断迭代计算，直到结果收敛为止。收敛性检查的标准

包括以下两个：

（1）残差：监测方程的残差，通常希望残差低于某个设定阈值。

（2）监测点：在关键位置设置监测点，观察流场变量（如速度、压力）的变化情况。

实际上，为了方便用户操作，许多商业 CFD 软件的求解器通常集成了大部分前处理功

能。例如，ANSYS CFD 中的 Fluent/CFX 软件，除了核心求解功能，还包含网格的输入、模

型的建立与选择、边界条件的设置和求解控制参数的配置等前处理的部分内容。真正的实现

求解过程是在用户单击“计算”按钮后开始的。

1.6.3　后处理

由于计算机技术的更新迭代，使图形处理的能力与效率得到了极大提升，目前许多专业

CFD 软件均配备了丰富而完备的后处理机调度，具备极其丰富的再加工能力。这些技术主要

包括：计算域几何类型的网格显示、各种矢量图（如速度矢量线）、等值曲线图、各物理量

的云图（填充型等值线图）、XY 散点图、粒子轨迹图，以及图像的处理功能（如平移、缩

放、旋转等）。

其中，ANSYS CFD（计算流体力学）后处理是对通过 CFD 仿真分析获得的数据进行分

析和可视化的过程。后处理的目的是从复杂的数值数据中提取有用的信息，以帮助工程师和

设计师理解流体流动的特性、性能与行为。借助完备的后处理功能，可以动态实时模拟流动

效果，清晰直观地观察分析 CFD 的计算结果。以下是 ANSYS CFD 后处理的一些关键步骤

和工具：

1. 导入计算结果

在完成 CFD 仿真后，计算结果通常保存在特定的文件格式中。使用 ANSYS 后处理工具

（如 ANSYS Fluent 或 ANSYS CFX）打开这些文件。

2. 可视化流场

（1）等值面（iso-surfaces）：显示特定变量（如速度、压力、温度）的等值面，有助于

分析流体的分布。

（2）矢量图（Vector Plots）：通过箭头或线条显示流动方向和速度，便于观察流动

模式。

（3）流线（Streamlines）：描绘流体在流动场中的路径，帮助分析流动特性。

3. 图形和数据分析

（1）剖面图（Cross-sections）：在特定的截面上查看变量分布，如速度剖面、压力剖

面等。

（2）时序动画（Transient Animations）：在瞬态分析中，通过动画展示随时间变化的流场

特征。
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（3）统计图表（Graphs）：绘制变量随时间或空间的变化图，帮助分析和比较不同条件

下的结果。

4. 数据提取与量化

（1）探针（Probes）：在特定点处提取数据，获取精确的数值结果。

（2）积分（Integrals）：计算流体的整体特性，如流量、升力、阻力等。

5. 后处理软件工具

（1）ANSYS Fluent Post Processing：适用于 Fluent 仿真结果的后处理，提供丰富的可视

化和分析功能。

（2）ANSYS CFX Post Processing：专为 CFX 用户设计的后处理工具，功能类似于

Fluent。
（3）ANSYS Discovery Live：提供实时后处理功能，便于快速评估设计的流体动力学

性能。

6. 报告生成

通过后处理工具生成详细的报告，包括图表、图像和数据，便于与团队成员和客户分享

分析结果。

7. 验证与分析

验证是确保模拟结果的可靠性和准确性的重要步骤。

（1）与实验结果比较：将模拟结果与实验数据进行比较，检查模型的有效性与可行性。

（2）网格独立性分析：进行不同网格密度的模拟，确保结果在网格变化下的稳定性。

8. 优化与调整

根据结果和验证情况，可能需要调整模型参数或边界条件，进行多次迭代以获得最佳

结果。

1.7　本章小结

为了帮助初学者快速入门计算流体力学，本章首先介绍了通过数值方法解决流体力学问

题的基本原理与基本思路，阐述了计算流体力学（CFD）的核心知识。接着，介绍了常用的

计算流体力学商业软件，并详细对比分析了它们的各自特点与应用范围。最后，简要介绍了

CFD 软件在前处理、分析运算和后处理方面的功能。通过学习本章内容，读者将能够为进一

步深入理解计算流体力学及掌握 CFD 软件的使用奠定扎实的理论和实践基础。
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创建几何模型

合适的几何模型能够准确地反映所研究的物理对象，是进行 ANSYS CFX 等各类数值模拟

分析的基础。高质量的几何模型不仅能够提高模拟的准确性，还能够减少网格修复的工作量、

提高网格质量，以及确保边界条件设置的准确性等。本章聚焦于 ANSYS Workbench 平台中的

DesignModeler 模块，帮助用户快速掌握在 DesignModeler 中创建复杂几何模型的方法和技巧。

2.1　创建几何模型概述

在进行流体力学计算分析之前，首先要根据所研究的对象建立几何模型。目前，创建几

何模型的方法主要有以下两种：

1. 通过网格生成软件直接创建模型

当下，常见的网格生成软件均有创建几何模型的功能。利用该功能所创建出的模型，其

几何精度处于较高水平，只是操作流程较为烦琐，在创建复杂几何模型时会面临较多困难。

2. 采用三维 CAD 软件进行几何建模

这种方法首先需借助 CAD 软件建立三维模型，随后需将其转换为网格生成软件可识别的

文件类型，进一步导入网格生成软件开展网格划分工作。这种方式能够创建出复杂的几何模

型，但模型没有网格生成软件创建的几何精度高，导入网格软件后，如有需要还得进行修复。

本章重点介绍 ANSYS CFX 中 DesignModeler 模块的使用方法，该模块操作较为便捷且

创建的模型精度较高。和大多数 CAD 软件类似，DesignModeler 在进行几何建模时，主要有

以下 3 种方法，如表 2-1 所示。

表 2-1　DesignModeler 几何建模方法

建 模 方 法 内　　容

自底向顶
是指依照点、线、面、体的先后顺序逐个开展建模操作，这种顺序与设计人员的建模思维逻辑相

契合，特别适宜在概念设计阶段针对产品进行建模工作

自顶向底 该方法是直接利用体素，通过布尔运算（如合并、分割和相交等方式）建立复杂的几何模型

混合使用前

两种方法

将前两种方法予以综合运用，不过需要考虑最终期望得到何种有限元模型，也就是在进行网格划

分操作时，是要达成自动网格划分还是映射网格划分。在进行自动网格划分的情况下，实体模型

的构建相对简易，只需确保所有的面或体能够合并成一个体即可；而在进行映射网格划分时，平

面结构必须由 3 条或 4 条边围合而成，体结构则要求由 4 个、5 个或者 6 个面围合而成
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2.2　DesignModeler 简介

DesignModeler 是 ANSYS Workbench 里用于创建几何模型的平台。DesignModeler 主要

是为 ANSYS 中的有限元分析及计算流体力学分析提供服务的，它具备一些普通 CAD 软件

所没有的功能，如全参数化建模能力、与 ANSYS Workbench 等其他模块的集成能力、概念

化模型创建能力等。

2.2.1　启动 DesignModeler

若要启动并运行 DesignModeler 应用程序，必须在 Workbench 中完成相应的操作。在

Workbench 中启动 DesignModeler 时，首先运行 Workbench 程序，接着导入 DesignModeler
模块，进而进入该程序，具体操作步骤如下：

（1）在 Windows 系统下执行“开始”→“所有程序”→ ANSYS 2022 R1 → Workbench 
2022 R1 命令，启动 Workbench 2022 R1。

（2）双击 Toolbox（工具箱）中的 Component Systems → Geometry 选项，即可在项目管

理区创建分析项目 A，如图 2-1 所示。

图 2-1　创建分析项目 A

（3）用鼠标右键单击该项目，在弹出的快捷菜单中选择 New Geometry in DesignModeler
命令，将直接进入 DesignModeler 软件。

2.2.2　DesignModeler 的用户界面

进入 DesignModeler 后，首先呈现在眼前的是 DesignModeler 的用户界面，如图 2-2 所示。

DesignModeler 的主要功能基本都汇聚于各项主菜单内，如创建文件、具体操作及帮助

文件等。主要有 7 个菜单选项，如图 2-3 所示。
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File：基本文件操作，包括常规的文件输入、输出、保存及脚本的运行等功能，如图 2-4所示。

 
图 2-2　DesignModeler 用户界面

　　
                         图 2-3　DesignModeler 主菜单　　　                         图 2-4　File 菜单

Create：用来创建 3D 模型和修改的操作工具（如布尔运算、倒角等），如图 2-5 所示。

Concept：用来创建梁模型和面（壳体）的工具，如图 2-6 所示。

Tools：其用途在于进行整体建模相关的操作、开展参数管理工作，以及实现对程序的定

制等方面的工具，如图 2-7 所示。

Units：用来设置模型所采用的单位制和模型识别精度。

View：用来设置显示项的工具，如图 2-8 所示。例如，在梁模型中利用显示功能可以直

观地看到梁单元的横截面。
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Help：帮助文档，在使用 DesignModeler 的过程中，碰到一些问题或有一些不清楚的地

方时可以随时使用，如图 2-9 所示。

　　 　　
                  图 2-5　Create 菜单　　         图 2-6　Concept 菜单　　          图 2-7　Tools 菜单

　　
                                          图 2-8　View 菜单　                    　图 2-9　Help 菜单

除了上述菜单，为了便于用户使用，DesignModeler 将一些常见的功能组成工具条形式放

置在主菜单下面，只要单击相应的图标就可以直接使用，常见的工具条如图 2-10 所示。

图 2-10　DesignModeler 工具条
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2.3　草图模式

在 DesignModeler 中，草图模式能够完成创建二维几何体。而这些二维几何体主要是为

后续创建 3D 几何体及开展概念建模工作做铺垫的。

2.3.1　进入草图模式

在着手开展一项新的模型设计工作之前，务必要在 Units 菜单里针对模型明确指定长度单

位，如图 2-11 所示，用户可以依据自身需求来挑选合适的长度单位。

2.3.2　创建新平面

在 DesignModeler 中，草图的创建需要基于平面来进行，所以使用者首先创建一个工作

平面，然后才能在上面绘制草图。

在工具条中单击 按钮创建新平面，构建新平面有以下几种类型，如图 2-12 所示，具

体含义如下。

　       
                   图 2-11　Units 菜单　　　           图 2-12　创建新平面

From Plane：从另一个已有面创建平面。

From Face：从表面创建平面。

From Centroid：通过三维模型的质心创建平面。

From Circle/Ellipse：基于某个圆或椭圆创建平面。

From Point and Edge：选取一个特定的点及一条直线作为边界条件，以此来对平面进行

定义。

Form Point and Normal：通过指定一个点及一条作为边界方向法线的直线对平面进行定义。

From Three Points：用三点定义平面。

From Coordinates：借助输入与原点之间的距离坐标及法线的相关信息对平面进行定义。
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2.3.3　创建草图

一旦平面创建完成后，便能够在该平面上着手新建草图了。在进行具体操作时，只需单

击草图按钮 ，即可在处于激活状态的平面上顺利创建草图。

此外，还可以从面直接建立面/草图的快捷方式。操作时只要先选中将要创建的新平面所

用的表面，随后直接切换到草图标签即可绘制草图。具体的实例过程如图 2-13 所示。

图 2-13　直接建立面/草图

进入草图模式界面后，可以在左侧看到一系列 Sketching Toolboxes 面板，如图 2-14
所示。

图 2-14　Sketching Toolboxes 面板 
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2.3.4　几何模型的关联性

DesignModeler 本身的建模虽然与 CAD 软件的建模思路非常类似，但是 DesignModeler
还有自己的特点。

DesignModeler 可以导入外部 CAD 几何体模型，如图 2-15 所示，一般包括以下 3 种方式：

图 2-15　与 CAD 软件的关联性

（1）在开启的 CAD 系统里进行探测操作，随后导入当下的 CAD 文件（执行 File → Attach  
to Active CAD Geometry 命令）。

（2）导入外部几何体时（执行 File → Import External Geometry File 命令），其几何体格式

包括 Parasolid、SAT 等。

（3）导入杆件模型（执行 File → Import Shaft Geometry 命令），通过一个描述杆件内

径、外径和长度的 .txt 文件建立杆件的 CAD 模型。

其 中， 第 一 个 功 能（ 执 行 File → Attach to Active CAD Geometry 命 令） 可 以 使

DesignModeler 与绝大多数 CAD 的几何模型建立双向关联性。双向关联性是指在外部 CAD
修改模型后，在 DesignModeler 刷新后，就可以更新为修改后的模型。

2.4　创建 3D几何体

3D 几何体是将 2D 几何体通过拉伸、旋转等操作生成的。

在 DesignModeler 中只有以下两种状态的几何体：

（1）激活状态的几何体：当几何体处于激活状态时，能够开展常规的建模操作，如布

尔操作等。不过，在这种状态下，该几何体是无法执行切片（Slice）操作的。切片操作是

DesignModeler 的特色功能之一，主要是为了在后续进行网格划分时，能够划分出规则的六

面体而设置的。
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（2）冻结状态的几何体：对几何体进行冻结操作，主要是因为只有在几何体处于冻结状

态时，才能够对其执行切片操作。在建模过程中，除了切片操作，其他的常规建模操作都无

法应用于冻结状态的几何体。

DesignModeler 包括 3 种体素，即 3D 实体（Solid Body）、面体（Surface Body）和线体

（Line Body）。图 2-16 所示为 3D 建模工具栏，其中的命令将在下面分别进行介绍。

图 2-16　3D 建模工具栏

2.4.1　拉伸

拉伸（Extrude）可以用于创建面体和 3D 实体。当前激活的 2D 草图作为拉伸命令默认

的操作图元，用户可以改变拉伸命令的属性，如拉伸长度、方向及布尔运算的方式，控制实

体或面体的创建。设置好拉伸属性后，单击 Generate 按钮，即可生成相应的实体。

例如，生成一个立方体，在创建一个矩形的草图后，选中草图，按照图 2-17 中的提示

单击 Extrude 按钮，设置立方体高度为 10m，然后单击 Generate 按钮，完成建模过程。

图 2-17　拉伸建模实例

2.4.2　旋转

旋转（Revolve）可以用于创建 3D 轴对称旋转体。整个创建过程与拉伸操作类似，也包

括选择、属性设定和创建 3 个步骤，区别是在选择时必须指定旋转轴。图 2-18 给出了用旋

转命令创建实体圆柱的操作过程。
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图 2-18　旋转建模实例

2.4.3　扫掠

扫掠（Sweep）可以用几何元素经过不同的路径在空间中扫描曲面。图 2-19 所示为矩形

沿着曲线扫描得到的模型。

图 2-19　扫掠建模实例
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2.4.4　直接创建 3D 几何体

与上述图元的创建类似，在 DesignModeler 中，用户可以通过指定角点、中心点，以及

通过坐标设定等方式创建棱锥体、圆锥体、球体和圆环体。该方法无须事先绘制 2D 草图，

使操作更加快捷，可以直接生成 3D 图元，如图 2-20 所示。

图 2-20　直接创建 3D 几何体建模实例

2.4.5　填充和包围

填充（Fill）和包围（Enclosure）这两个操作在 CFD（计算流体力学）计算建模过程中

经常会用到如图 2-21 所示的某种简化的接头，流体在接头内流动。下面对接头内的流体进

行分析。在 CAD 建模时只是创建了接头的固体部分，而 CFD 分析实际是对接头空腔内的流

体进行分析。在这种情况下，只需运用填充操作，便能够构建出流体部分的几何体。

下面以此为例说明填充的操作过程。

（1）在主菜单中执行 Tools → Fill 命令。

（2）用鼠标在选择过滤器中选择面。

（3）选中内腔的壁面。

（4）在屏幕左下方的详细栏中确定为 By Cavity（腔填充），并单击 Apply 按钮。

（5）单击 Generate 按钮，生成流体区域，重命名为 Fluid。
隐去原有的固体区域，即可看到产生的流体区域，如图 2-22 所示。

对于包围操作，如对正在飞行的导弹周围的空气流场进行分析，一般在建模时只会对固

体的导弹建模，而分析时是将导弹周围的空气作为研究对象。
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                               图 2-21　接头模型　                                           　　图 2-22　填充操作过程

此时只要采用包围操作，就能对周围的空气建立模型。包围操作与填充操作类似，本书

就不再详细赘述了。

2.5　导入外部CAD文件

用户可用自身所熟悉的 CAD 系统预先创建好模型，接着把模型导入至 DesignModeler
里。DesignModeler 的一项优势在于，可与众多主流 CAD 软件共同开展建模工作，它不但

能够读取外部 CAD 模型，而且还能够嵌入到主流 CAD 软件系统中。在 CAD 软件中创建好

模型后，可将模型转换为第三方格式，进而导入 DesignModeler 内。当下，DesignModeler
所能读取的外部模型格式包含 ACIS、AutoCAD、CatiaV4、Catia V5、Creo Elements/Direct 
Modeling、Creo Parametric、GAMBIT、IGES、Inventor、JTOpen、Monte Carlo N-Particle、
Parasolid、SolidWorks、STEP、Unigraphics NX 等。

想要导入外部 CAD 文件，执行 File → Import External Geometry File 命令，在弹出的对

话框中选择相应的文件即可，如图 2-23 所示。

　
                               （a）快捷菜单                                                     （b）“打开”对话框

图 2-23　导入第三方格式文件操作过程 1
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（c）几何模型显示

图 2-23　导入第三方格式文件操作过程 1（续）

目前，DesignModeler 能嵌入的主流 CAD 系统有 AutoCAD、BladeGen、CATIA、Creo 
Modeling、Pro/ENGINEER、Inventor、UG NX 和 SolidWorks。

若想将 DesignModeler 嵌入 CAD 系统中，首先要安装相应的 CAD 系统，然后在安装

ANSYS 时进行相应的设置。如果安装时没有设置，那么可以安装完成后在 ANSYS 的 CAD 
Configuration Manager 2022 中进行设置，如图 2-24 所示。在 Windows 中可以通过执行“开

始”→“所有程序”→ ANASYS 2022 R1 命令，找到 CAD Configuration Manager 2022 R1
选项，然后完成相关操作。

图 2-24　导入第三方格式文件操作过程 2
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如果当前 CAD 系统已打开，那么从 DesignModeler 输入 CAD 模型后，CAD 系统与

DesignModeler 自动保持双向刷新功能。若需要采用参数化双向刷新功能，则参数采用的默

认格式是 DS-XX 形式。这样，两者之间就能通过改变参数值相互刷新几何体了。

当然，DesignModeler 具备从外部导入几何体的能力，与之相对应，其亦能实现向外输

出几何体模型的功能。相关操作为在菜单栏中执行 File（文件）→ Export（导出）命令，如

图 2-25 所示。

图 2-25　DesignModeler 几何模型输出

2.6　应用实例

2.6.1　活塞实例

（1） 在 Windows 环 境 下， 依 次 执 行“ 开 始” →“ 所 有 程 序” → ANSYS 2022 
R1 → Workbench 2022 R1 命令。

（2）进入 Workbench 2022 R1 后，在任务栏中单击 按钮，在弹出的 Save Case（保存

项目）对话框的 File Name 处输入“huosai.wbpj”，再单击 Save 按钮，保存项目文件。

（3）双击主界面 Toolbox 里的 Component Systems → Geometry 选项，创建分析项目 A。

（4）双击项目 A 的第二栏 Geometry，进入 DesignModeler 界面，在 Units 菜单中设置单

位为 Millimeter，单击 OK 按钮确认，如图 2-26 所示。

（5）在 Geometry 树中，选择 ZXPlane 选项，以此来选定 ZX 平面作为草图放置的平

面。接着单击草图按钮 ，新建一个名为 Sketch1 的草图，具体情形可参照图 2-27 所示的内

容。为了便于操作，可单击 按钮，选择视图正视自己的视角。
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                             图 2-26　设置单位　                                                    　    图 2-27　创建草图

（6）在细节展示区内选择 Sketching 选项卡，进入 Sketching Toolboxes 窗口，单击 Draw
（画图）中的 Rectangle（矩形）选项，在图形工作区两处不同的地方分别单击，生成一个

矩形，同理再生成一个矩形，如图 2-28 所示。

图 2-28　绘制矩形

（7）单击 Dimensions（尺寸）中的 Horizontal（水平）选项，将下方矩形右侧线到 x 轴的

距离设置为 25mm，下方矩形左侧线到 x 轴的距离设置为 40mm。单击 Dimension（尺寸）

中的 Vertical（竖直）选项，将下方矩形长设置为 100mm，上方矩形长设置为 35mm，两个

矩形之间的距离设置为 30mm，如图 2-29 所示。

（8）单击工具栏中的 Revolve（旋转）按钮 ，Geometry 单击选中上述创建的草图 Sketch1，
Axis 选中 x 轴，单击工具栏中的 Generate（生成）按钮 ，生成三维几何体，如 2-30 所示。
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图 2-29　尺寸设置

 
图 2-30　生成三维模型

2.6.2　齿轮实例

（1）在 Windows 环境下，依次执行“开始”→“所有程序”→ ANSYS 2022 R1 → 
Workbench 2022 R1 命令。
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（2）进入 Workbench 2022 R1 后，在任务栏中单击 按钮，在弹出的 Save Case（保存

项目）对话框的 File Name 处输入“chilun.wbpj”，再单击 Save 按钮，保存项目文件。

（3）双击主界面 Toolbox 里的 Component Systems → Geometry 选项，创建分析项目 A。

（4）双击项目 A 的第二栏 Geometry，进入 DesignModeler 界面，在 Units 菜单中设置单

位为 Millimeter，单击 OK 按钮确认，如图 2-31 所示。

（5）在 Geometry 树中单击 YZPlane 选项，选择 YZ 平面为草图放置平面，然后单击草

图按钮 ，新建草图 Sketch1，如图 2-32 所示。为了便于操作，可单击 按钮，选择视图

正视自己的视角。

　　　
                                         图 2-31　设置单位                                                 图 2-32　创建草图

（6）在细节展示区内选择 Sketching 选项卡，进入 Sketching Toolboxes 窗口，单击 Draw
（画图）中的 Circle（圆形）选项，在图形工作区单击并拖动鼠标，生成一个圆形，然后单

击 Draw（画图）中的 Rectangle（矩形）选项，在图形工作区两处不同的地方分别单击，生

成一个矩形，如图 2-33 所示。

图 2-33　绘制草图 1
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（7）单击 Dimensions（尺寸）中的 General（一般尺寸）选项，设置圆直径为 38mm，矩形

长为 200mm，宽为 100mm，矩形下边框到 x 轴间的距离为 50mm，如图 2-34 所示。

图 2-34　草图 1 尺寸设置

（8）在 Geometry 树中单击 YZPlane 选项，选择 YZ 平面为草图放置平面，然后单击草

图按钮，新建草图 Sketch2，选择视图正视自己的视角。

（9）在细节展示区内选择 Sketching 选项卡，进入 Sketching Toolboxes 窗口，单击 Draw
（画图）中的 Rectangle（矩形）选项，在图形工作区圆边框附近单击两处不同的地方，生

成一个矩形，如图 2-35 所示。

图 2-35　绘制草图 2
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（10）单击 Dimensions（尺寸）中的 General（一般尺寸）选项，设置小矩形宽为

3mm。单击 Dimensions（尺寸）中的 Horizontal（水平）选项，将小矩形左侧线到 z 轴的距

离设置为 1.5mm。单击 Dimension（尺寸）中的 Vertical（竖直）选项，将小矩形上侧线到 y
轴的距离设置为 25mm，如图 2-36 所示。

图 2-36　草图 2 尺寸设置

（11）在菜单栏中单击 Concept 菜单，选择 Surfaces From Sketches 命令，在弹出的

“创建草图表面”对话框中设置 Base Objects 为 Sketch1，Operation 为 Add Material（添加

材料），然后单击 Generate（生成）按钮 生成 SurfuceSk1。采用同样的步骤，设置 Base 
Objects 为 Sketch2，Operation 为 Add Frozen（冻结），其余步骤不变，生成 SurfuceSk2，如

图 2-37 所示。

图 2-37　创建草图表面
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（12）在菜单栏中单击 Create 菜单，选择 Body Transformation 中的 Rotate（旋转）命

令，在弹出的“旋转”对话框中设置 Preserve Bodies 为 Yes，Bodies 为上面创建的 SurfuceSk2， 
Axis Selection 为 x 轴，Angle 为 30°，然后单击 Generate（生成）按钮 生成 Rotate1。采

用同样的步骤，Angle 输入 60°、90°、120°、150°、180°、210°、240°、270°、

300°、330°，依次生成 Rotate2 ～ Rotate11，如图 2-38 所示。

 
图 2-38　创建旋转面

（13）在菜单栏中单击 Create 菜单，选择 Boolean（布尔运算）命令，在弹出的“布尔运

算”对话框中设置 Operation 为 Subtract（减去），Target Bodies 为上面创建的 SurfuceSk1，
Tool Bodies 为上面创建的 SurfuceSk2，Preserve Tool Bodies 为 No，然后单击 Generate（生

成）按钮 生成 Boolean1。采用同样的步骤，Target Bodies 保持不变，Tool Bodies 依次选择

上面创建的 Rotate2 ～ Rotate11，依次生成 Boolean2 ～ Boolean12，如图 2-39 所示。

图 2-39　布尔运算
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2.6.3　水箱实例

（1）在 Windows 环境下，依次执行“开始”→“所有程序”→ ANSYS 2022 R1 → Workbench 
2022 R1 命令。

（2）进入 Workbench 2022 R1 后，在任务栏中单击 按钮，在弹出的 Save Case（保存

项目）对话框的 File Name 处输入“shuixiang.wbpj”，再单击 Save 按钮，保存项目文件。

（3）双击主界面 Toolbox 里的 Component Systems → Geometry 选项，创建分析项目 A。

（4）双击项目 A 的第二栏 Geometry，进入 DesignModeler，在 Units 菜单中设置单位为

Millimeter，单击 OK 按钮确认，如图 2-40 所示。

（5）在 Geometry 树中单击 ZXPlane 选项，选择 ZX 平面为草图放置平面。单击草图按

钮 ，新建一个名为 Sketch1 的草图，具体情形可参照图 2-41。为了便于操作，可单击

按钮，选择视图正视自己的视角。

　　　
                                       图 2-40　设置单位　　                              　图 2-41　创建草图

（6）在细节展示区内选择 Sketching 选项卡，进入 Sketching Toolboxes 窗口，单击 Draw
（画图）中的 Rectangle（矩形）选项，在图形工作区两处不同的地方分别单击，生成一个

矩形，如图 2-42 所示。

图 2-42　绘制矩形
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（7）单击 Dimensions（尺寸）中的 General（一般尺寸）选项，设置矩形长为 300mm，

宽为 150mm，如图 2-43 所示。

图 2-43　尺寸设置

（8）单击工具栏中的 Extrude（拉伸）按钮 ，选中上面创建的草图，并在 Details View
选项组中设置 Depth（高度）为 20mm，单击工具栏中的 Generate（生成）按钮 ，生成三维

几何体，如 2-44 所示。

图 2-44 　生成三维模型
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 第 2 章 创建几何模型

2.7　本章小结

本章系统介绍了如何利用 ANSYS Workbench 中的 DesignModeler 模块创建几何模型，

包括建模方法、界面操作、草图绘制、3D 几何体创建、外部文件导入及实例操作等内容，

帮助用户掌握在 DesignModeler 中创建几何模型的方法和技巧。


